Labb 3: ASP.NET 2.0 Anpassningar av
anvandargranssnittet: Master Pages, Teman,
och Kontroller

Beréknad tidsatgang:
60 minuter

Labbforberedelser

I ASP.NET 2.0 finns ett stor méngd nya funktioner for att forenkla
utvecklingen av anvandargranssnittet, tex. master pages, teman, och skins. Allts
som allt mer &n 50 nya kontroller for att effektivisera utvecklingen av vanliga
anvandargranssnitt.

I denna labb skaffar du dig erfarenhet av att anvénda en del av dessa funktioner
genom att forbattra utseendet pa det du skapade i labb2. Forst skall du lagga till
en “master page” till ditt webbprojekt. Sedan skall du lagga till ett tema for
dina sidor. Slutligen skall du lagga till en "MultiView” kontroll som ger dina
bestkare mojlighet att vélja hur data om bdckerna skall visas och du skall
kombinera ”DataL ist” kontroller med anpassade HTLM hanterare for att skapa
en ny vy dver “comic” databasen.

Ungefar sd har kommer sidan att se ut nar den ar Klar:
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Om du inte &r klar med Labb2 sé lagger jag upp fardig kod pa min hemsida att
utga fran.

Ladda ner filen med teman (Thems.zip)frdn min hemsida till din dator och
packa upp den. (teman som jag laddat ner fran Microsoft)

Om du inte aktiverat databascachning i labb2 gor da enligt foljande:

a. Oppna Visual Studio kommandopromptfonstret. Du hittar det under “Alla
Program -> Microsoft Visual Studio 2005 -> Visual Studio Tools > Visual
Studio Command Prompt.”

b. Navigera till katalogen dér du dina databasfiler. C:\...\...\katalog.

c. Skriv CacheSetup i kommandoprompten.



Ocning 1

Skapa en master page

Du skall i denna 6vning skapa en “master page” for dina sidor Default.aspx, Details.aspx, Admin.aspx,
och &ven for kommande sidor som skall vi kommer att skapa senare. Sedan skall du modifiera dina
existerande sidor for att gora dem till “content pages”.

Uppgift Detaljerad beskrivning
1. Oppna “Web . Kopiera katalogen dar filerna fran labb2 finns till en ny kattalog. D6p om katalogen till Lab3
site” . Starta Microsoft Visual Studio 2005 och &ppna kopian av labb2 med Open Web Site.
Hogerklicka pa C:\..\Lab3 i Solution Explorer fonstret och valj “New Folder.” DGp
mappen till Images.

. Hogerklicka pa "Images” mappen och valj “Add Existing Item” for att lagga till en bild
till mappen. Jag lagger upp nagra bilder | gif format pd min hemsida som ni kan ta ner
och anvénda, annars kan ni &ven anvéanda en egen bild men den bér inte vara allt for
stor.

2. Laggtill en Haogerklicka pa C:\..\Lab3 i Solution Explorer och vilj “Add New ltem.”

“master page”

. Valj “Master Page” som template och dép den Site.master. Kontrolera s att C# ar valt

som sprak och att rutan “Place code in separate file” ar ikryssad = Add.

Vélj Internet Explorer 6.0 som “Target Schema for Validation” i drop-down listen |
verktygsfaltet.

. Vaxla till design vyn.

3. Bestdm layout
for master

page

a. Valj “Insert Table” fran Visual Studio-s Layout meny.

Markera Template i ”Insert Table” dialogen och vélj “Header, footer, and side” i drop-
down listen enligt nedan. > OK for att lagga till tabellen till "master page”.

Select a table template from the drop-down list or build your own custom table,

Header, footer and side j

™ Custom:
Layout
Rows: m ™ sidth:
Eolurmns: Iﬂ IT m
Align; Mot Set I™ Height:
[~ Caption I 100 I_": [%jv
- Attributes
I~ Border: m Sumnmary, descripkion:
[~ Cellpadding: m
™ Cellspacing: m

el Properties, .. | Ok I Cancel |

Ta tag i titel faltet pa "ContentPlaceHolder” kontrollen och flytta den till cellen till
hdger i andra raden.

. Placera markoéren i samma cell(inte i “ContentPlaceHolder”). Ange VVAlign egenskapen

(i Properties fonstret) for cellen till "top”. Nu skall "ContentPlaceHolder” kontrollen
hamna langst upp 1 cellen.

Hogerklicka i tabellens Gversta rad och vélj “Insert>Row Below” fran
rullgardinsmenyn.

Markera den nya raden och satt dess hoéjd till 1 och BgColor till Gray.

Hogerklicka i tabellens nedresta rad och vélj “Insert->Row Above” fran
rullgardinsmenyn.




h. Markera den nya raden och sétt dess héjd till 1 och BgColor till Gray.

i. Hogerklicka i cellen till vanster om den som innehaller “ContentPlaceHolder”
kontrollen och valj “Insert->Column to the Right.”

j. Placera markdren | den nya cellen och ange cellens bradd till 1 och dess BgColor till

Gray.
k. Markera tabellens dversta rad. Ange dess BgColor to “#e7e7e7”.
I.  Placera markdren i cellen langst till vanster i mitten raden. Ange BgColor till “#ececec.
m. Markera tabellens nedersta rad och ange dess BgColor till “#ececec”.
n. Véxla till kod vyn och modifiera manuellt <body> taggen enligt nedan:
<body topmargin="0" bottommargin="0" leftmargin="0" rightmargin="0">
o. Vaxa tillbaka till design, sidan skall nu se ut ungefar sa har:
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4, Lagg till
innehall pa
master page

a. Draen "HyperLink” kontroll fran verktygsfaltet och slap den i tabellens Gversta rad.

a. Ange “HyperLink” kontrollens “ImageUrl” egenskap till “~/Images/filnamn.gif” och
dess “NavigateUrl” egenskap till “~/Default.aspx”.

b. Markera tabellens dversta rad. Ange dess hojd till 1 s att denna justerar hojden sjalv sd
att den stimmer med bildens hojd.

Placera markoren i cellen langst till vanster i mittenraden. Ange dess bradd till 128.

d. Markera tabellens nedersta rad och ange dess hdjd till 16.

e. Lat markoren std kvar i den nedersta raden och ange dess font till 8-punkter Verdana
och skriv Om denna sida fungerar s har jag byggt den, om den inte fungerar sa har jag
ingen aning om vem som byggt den” Master sidan skall nu se ut ungefar s har i design
lage:
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5. Convert
existing pages
into content
pages

Dubbelklicka pa Default.aspx i Solution Explorer for att 6ppna den.

b. Véxla till kod lage och lagg till ett MasterPageFile="~/Site.master" attribut till @ Page
direktivet langst upp.

c. Tabort <IDOCTYPE>, <html>, <head>, <body>, <form>, och <div> elementen fran
sidan. L&gg till ett <asp:Content> element som innesluter allt innehall som finns kvar pa
sedan:

<asp:Content ID="Content1" ContentPlaceHolderID="ContentPlaceHolder1" Runat="server">

</asp:Content>
d. L&gg till ett Title="MyComics” attribut till Default.aspx-s @ Page direktiv.

e. Repitera proceduren a till d for Details.aspx och Admin.aspx sa att &ven dessa blir
content sidor.

f. Markera Default.aspx i Solution Explorer. = Ctrl+F5 for att starta.
g. Kontrolera sa att Default.aspx har blivit en “content page”:
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h. Klicka pa en av GridView kontrollens select knappar for att visa Details.aspx. Kontrlera
ass dven denna har blivit en ”content page”.




Oppna Admin.aspx i webblisaren och kontrolera sé att d&ven denna &r en “content page”.

j. Stang webblasaren och atervand till Visual Studio.
6. Snygga till Oppna Default.aspx och vaxla till design lage.
Default.aspx Placera markéren under GridView kontrollen och infoga en tabell med “Layout-> Insert
Table”. | dialogen "Insert Table” valj templaten Header enligt nedan. > OK.
Select a table template from the drop-down list or build your own custom table.
" Custom:
rLayout
Rovs: 3 E I it
i 5= e [ ]
alin; Im I Height:
" Caption |1'"'— I_L,
Attributes
I” Eorder: 0 - Summaty. descrption:
I cellpadding: 0 -
[™ cellspacing: i -
el Froperkies, . | ITI Cancel |
c. Drade existerande ”SqglDataSource” och “DropDownList” kontrollerna till tabellens
dversta rad.
d. Dra de existerande ”ObjectDataSource” och “GridView” kontrollerna till tabellans
nedersta rad.
e. Radera allt tomrum (whitespace) mellan tabellens dversta rad och éverdelaen av sedan
sa att tabellens 6verdel samanfaller med 6verdelen av sidan.
f. Hogerklicka tabellena dversta rad och valj “Insert>Row Below.”
g. Ange den nya radens hojd till 1 och dess "background color” (BgColor) till Gray.
h. Ange den dversta radens hojd till 32 och dess background color till “#ececec”.
i. Infoga ett mellanslag eller tva till vanster om "DropDownList” kontrollen for att flytta
ut den en bit fran tabellens ram.
j. Markera DropDownListen. Ange fonten till 10 punkter Verdana i properties fonstret.
k. Ange GridView kontrollens teckensnitt till 10-punkter Verdana.

Starta Default.aspx i din webbl&sare, sedan skall se ut ungefar som nedan:
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m. Stang webblésaren och atervand till Visual Studio.




. formatera a. Oppna Details.aspx i design lage.
Details.aspx b. Ange “DetailsView” kontrollens teckensnitt till 10 punkter Verdana.

. formatera c. Oppna Admin.aspx | design lage.

Admin.aspx d. Upprepa de steg du utférde for Default.aspx i uppgift 6 fér Admin.aspx. Alternativt kan
du kopiera den HTML du lade till i Default.aspx till Admin.aspx.

e. Ange DetailsView kontrollens teckensnitt till 10 punkter Verdana.




Ovning 2

Ange ett tema fOr sidorna

Teman &r en enkel mekanism att anvanda for att applicera visuella attribut till kontroller.
Du kan applicera teman pa enskilda sidor eller en hel website. | den har 6vningen skall
du ange ett tema for hela webbsiten. Sedan skall du anpassa temat och anvanda det for
att ge ett gemensamt utseende till din site.

Uppgift Detaljerad beskrivning
1. Tabort a. Oppna Default.aspx i design lage. Markera GridView kontrollen och klicka pa smart
formatering kontrollen, den lilla pilen uppe till hdger, for att visa “GridView” kontrollens " Tasks” meny.

frén GridView. | p. vilj “Auto Format” och anvénd valet “Remove Formatting” for att ta bort all formatering
som du lade till i lab 2.

c. Kor Default.aspx i webblasaren. Hur ser "GridView” kontrollen ut nu?
d. Stang webblasaren och atervand till Visual Studio.

2. Lagg till temat a. Lagg till en folder med namnet “App_Themes” genom att hogerklicka pa C:\..\Lab3 i

“BasicBlue” Solution Explorer och vélja “Add ASP.NET Folder > Theme.

till b. D&p den automatgnererade foldern till “BasicBlue”.

Default.aspx c. Hogerklicka pd App_Themes\BasicBlue mappen | Solution Explorer och valj “Add Existing
Item.”

d. Vilj temafilen som du laddat ner ex. C:\...\\..\Themes\BasicBlue\BasicBlue.skin for att
skapa en lokal kopia av filen i din App_Themes\BasicBlue mapp.

e. Laggtill en folder med namnet “Images” till App_Themes \BasicBlue mappen.

f. Hogerklicka pa App_Themes\BasicBlue\Images mappen i Solution Explorer och valj “Add
Existing Item.”

g. Valjallafiler i \\..\Themes\BasicBlue\Images mappen for att skapa en local kopia av dem i
App_Themes \BasicBlue\Images mappen.

h. Oppna Default.aspx i kodlage och l4gg till ett Theme="BasicBlue” attribut till @ Page
direktivet.

i. Kor Default.aspx i din webblasare. Sidan skall se ut ungefar som nedan, med alternerande
farger pa raderna i grid kontrollen:
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j. Stang webblasaren och atervand till Visual Studio.

3. Utveckla ett a. Hogerklicka pd App_Themes mappen och vélj "Add ASP.NET Folder > Theme”. Dop
eget tema mappen MyComics.
b. Hogerklicka pa App_Themes\MyComics mappen i Solution Explorer och vilj “Add Existing
Item.”

c. Valj BasicBlue.skin fran sitens egen Themes\BasicBlue mapp for att skapa en kopia av den i




Themes\MyComics.
Dop om filen till “MyComics.skin”.
Dubbelklicka pd MyComics.skin i Solution Explorer fonstret.

Anvénd Visual Studio-s “Edit->Find and Replace->Quick Replace” komando for att byta ut
alla forekomster av “#000066” with “#e7e7e7”.

Byt ut alla “#eeeeee” med “lightyellow”.
Stang fonstret ”Quick Replace” och spara den modifierade filen..
Ldagg till en mapp med namnet “Images” till Themes\MyComics mappen.

Hogerklicka pd Themes\MyComics\Images mappen i Solution Explorer och valj “Add
Existing ltem.”

Vélj alla filer i sitens egen Themes\BasicBlue\Images map for att skapa en local kopia av
filerna i Themes\MyComics\Images.

Andra Theme attributet i Default.aspx @ Page direktiv till Theme="MyComics.”

. Starta Default.aspx i din webblésare och notera férandringarna i sidan.

Stang webblasaren och &tervand till Visual Studio.

4. Légg till tema
till alla sidor

4
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Oppna Default.aspx i kod lage och ta bort tema attributet fran @ Page direktivet.
Oppna Details.aspx i design lage.

Markera DetailsView kontrollen och valj “Auto Format” i “DetailsView” kontrollens
“Tasks” meny for att radera all formatering frén DetailsView kontrollen.

Oppna Admin.aspx i Design lage.
Ta bort all formatering fran Admin.aspx GridView kontroll och DetailsView kontroll.
Dubbelklicka pa Web.config i Solution Explorer for att 6ppna den.
Lé&gg till féljande till <system.web> delen i Web.config:
<pages theme="MyComics" />
Stang web.config och spara dina férandringar.
Starta Default.aspx i i din webblaasare och kontrolera s att sidan har temat “MyComics.”

Klicka pa en av Select knapparna for att visa Details.aspx. Kontrollera sé att dven den pé
samma satt som Default.aspx har temat MyComics.

Andra URL i webblasaren for att visa Admin.aspx och kontrollera sa att &ven denna har
samma tema.

Stang webblasaren och &tervand till Visual Studio.




Ovning 3

Lagg till multi vyer

I den har 6vningen skall du lagga till en “MultiView” kontroll till Default.aspx och fyll den med tva vyer:
En som presenterar sedan sa som den ser ut nu och en annan som anvander “DataL.ist” kontrollen for att
presentera innehallet pa ett helt annat sétt. ”DataL.ist” kontrollen skall anvanda en anpassad HTTP
hanterarere med namn ”ImageGrabber.ashx” for att hamta omslagsbilder fran databasen och visa dem pa
sidan. Du skall &ven l&gga till knappar for att byta mellan vyerna.

Uppgift Detaljerad beskrivning
1. Léaggtillen a. Hogerklicka pa c:\..\Lab3 mappen i Solution Explorer och valj “Add Existing Item” for
anpassad att skapa en lokal kopia av filen \Components\imageGrabber.ashx.

HTTP handler

b. Oppna ImageGrabber.ashx och titta pd koden som finns dar. Den innehéller en
dynamiskt kompilerad HTTP handler som ldser “comic book ID” fran en fragestrang
och anvénder den for att anropa och frdga MyComics databasen efter “comic book
cover” bild. For att forbattra prestandan s cachas omslagsbilden i ASP.NET
applikationens cache, den anvéander “SglCacheDependency” objekt for att uppdatera
cachade omslagsbilder om bilderna i databasen &ndras. Strax skall du anvanda
ImageGrabber.ashx som mal for ASP.NET Image controller for att hamta comic book
omslagsbilder fran databasen och visa dem.

2. Lé&ggtillen
MultiView
kontroll till
Default.aspx.

Oppna Default.aspx i design lage.
. Draen "MultiView” kontroll fran verktygsfaltet och slapp den pa sidan alldeles under
“GridViewl”.
c. Draen "View kontroll frn verktygsfaltet och slapp den i MultiView kontrollen. Den
vyn blir Viewl.

d. Dra”GridViewl” kontrollen till sidan och sépp den i Viewl.

!/ Drainte in en ny GridView till sidane. Du skal bara flytta GridView till View1.

e. Draen annan ”View” kontroll frn verktygsfaltet och slapp den pa “MultiView”
kontrollen. Den vyn blir View2.

f.  Ange MultiView kontrollens ActiveViewlIndex egenskap till 0.
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uppgift Detaljerad beskrivning
3. Laggtill en a. Draen ”DataList” kontroll till sidan och slédpp den i View?2.
Dmﬂm_ b. Anvand “DataList Tasks” menyn for att koppla ObjectDataSourcel som DataL ists
kontroll till kontrollens data kalla. Sidan skall sedan se ut ungefar s& har:
MultiView

C.

C#

Admin.aspx | Details.aspx - Default.aspx® | Site.master | Start Page

Content - Contentl (Custom)

I%qlDal:aSourl:e - SglDatasourcel
fbatabound

I?Zlhital:l:DaI:aSourl:e - ObjectDataSourcel

i Multiview1

B View1

B , . |
Title Number Year Grade Certified? ¥Yalue :

Select Databound Databound Databound Databound Databound abi

Select Databound Databound Databound Databound Databound abi

Select Databound Databound Databound Databound Databound akbe

Select Databound Databound Databound Databound Databound akbe

Select Databound Databound Databound Databound Databound akbe

B View?2

%ataList - Datalist1

Right-click or choose the Edit Templates task to edit template content,
The ItemTemplate is required,

Vaxla till kod l&ge och lagg till féljande <ltemTemplate> till DataList kontrollen.
Notera anvandningen av ”Image” controller vars ImageUrl attribut pekar pé
ImageGrabber.ashx som renderar bilderna fran databasen, och de forenklade
databindnings uttryck som gér HTML templates mer palitliga:

<ltemTemplate>

<table cellpadding="4">

<tr>

<td width="100"">

<asp:Image ID="Coverlmage"

ImageUrl="<%# "'~/ImageGrabber.ashx?ComiclD="" + Eval
('ComiclD'™) %>"

Runat=""server' />

</td>

<td valign="top" style="font-family: Verdana; font-size:
10pt'>

<asp:Label ID="ComiclID"™ Text="<%# Eval ('ComiclD'™) %>~
Visible="false" Runat="server' />

<asp:LinkButton Text="<%# Eval ("'Title'") + "&nbsp;"
+ Eval (“'Number') %>" Runat="'server" /><br />
<%# (bool) Eval ('CGC'™) ? "CGC " : " %>

<%# Eval ('Grade', "{O:f1}'") %>

</td>

</tr>

</table>

</ltemTemplate>

d. Vaxla tillbaka till design lage och ange “DataList” kontrollens “RepeatColumns”
egenskap till 3 for att dela resultatet i 3 kolumner.
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e. Ange "DataL.ist” kontrollens “RepeatDirection” egenskap till “Horizontal” for att
organisera posterna | rad forst (istallet for kollumn férst) ordning.

f.  Ange "DataL.ist” kontrollens ”CellPadding” egenskap till 8.

g. Ange "DataList” kontrollens "EnableTheming” egenskap till False.

h. Markera "DataList” kontrollen i design lage, klicka p blixt ikonen i Properties flndtret
for att visa en lista 6ver event for "DataList” kontrollen. Dubbelklicka pa
“ItemCommand” for att l4gga till en ItemCommand eventhanterare till Default.aspx.cs.

i. LA&gg till féljande kod till eventhanteraren:

C#

Label label = (Label) e.ltem.FindControl (*'ComiclD");
Response.Redirect (‘'Details.aspx?ComiclD="" + label.Text);

j. Starta Default.aspx. Sidan ser lika dan ut som tidigare. Med andra ord, det &r GridViewn
som visas, inte DatalL isten. VVarfor?

k. Stang webblasaren och &tervind till Visual Studio. Andra MultiView kontrollens
”ActiveViewlIndex” egenskap till 1.

I. Starta igen. Sidan skall nu se ut ungefar s har:

@ - Iﬂ ig ; /- =13 Favariter 6“ il = ) @ Ez/l’ 3:‘1 l
Adress Q'I http:fflocalhost: 4238/Lab3{Def aulk, aspx
e
Mittuniversitetet
_‘ MID SWEDEN UNIVERSITY
MWET Man 1 MET Man 2
6,0 9,0
MET Man #1 .NET Man 52 MET I
MNET Man 4 MET Man 5
9,0 CGC 9,0
NET Man #4 .NET Man #5
m. Klicka pa en av boktitlarna och kontrolera sa att Details.aspx visar detaljer for vald bok.
n. Stang webblasaren och atervand till Visual Studio.
4. Légg till a. Nasta uppgift ar att l4gga till ett par knappar for att byta vy interaktivt. Bérja med att
knappar for att dndra "MultiView”kontrollens “ActiveViewIndex” egenskap tillbaka till to 0.
byta vy b. Léagg till en "Button” kontroll pa Default.aspx, placera den alldeles till hdger om
DropDownListen. Lagg till ndgra mellanslag for att skapa lite luft mellan
DropDownL.isten och knappen. Ange féljande egenskaper fér knappen:
Text = "GridView"
EnableTheming = false
Width = 100
c. Léagg till ytterligare en knapp pé sedan. Placera den alldeles till hoger om den knapp du

just skapat. Se till att I&gg till lite mellanrum héar med. Ange féljande egenskaper for

knappen:
Text = "DatalList"
EnableTheming = False
Width = 100
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d. Dubbelklicka pa “GridView” knappen och lagg till foljande kod till eventhanteraren:
Ctt
MultiViewl_ActiveViewlndex = 0;

e. Atergd till Default.aspx i design lage och dubbelkicka pa “DataList” knappen och lagg
till féljande kod til eventhanteraren:

C#
MultiViewl._ActiveViewlndex = 1;

Om knapparna vore deklarerade i MultiView kontrollen sé kunde du ha
implemeterat vaxligen av vyer deklarativt genaom att ange kanpparnas
“CommandName” egenskap till “SwitchViewByIndex” eller “SwitchViewByID”
och ange varje knapps "CommandArgument” egenskap till respektive "view ID”
eller "view index”. Har maste vi dock skriva tva rader kod eftersom vi vill ha
knapparna definierade utanfor "MultiView” kontrollen.

f.  Kor Default.aspx i webblésaren och kontrollera sa att knapparna fungerar. Ungefar sa
héar skall sidan se ut nar “DataL.ist” vyn &r vald:

Atkiv - Redigera  Visa  Favoriter  Werkbyg  Hjdlp

OEakSt M ] ﬂ IELI .‘ /.7 ) sk v\( Favoriter {F‘ T i E @ @ E’p? ﬁ}

Adress ij http:/flocalhost:4236/Lab3/Default . aspx

L4

Mittuniversitetet
. MID SWEDEN UNIVERSITY

- Gridview | | Datalist
MET Man 1 MNET Man 2
6,0 9,0
NET Man #1 NET Man #2 NET
MET Man 4 MET Man 5
0,0 CGC 9,0
MNET Man #4 .NET Man #5

Du kanske maste valja en titel i dropdown listen efter att du klickat pa
“DataList” knappen for forsta gangen for att boken skall synas. Det kan
aven hénda att dropdown listen och resultatet | sedan inte riktigt synkar nar
man vaxlar fram och tilloaka mellan vyerna flera ganger.
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Summering

Detta har du lart dig i denna labb:

Hur man skapar en master page

Hur man konverterar befintliga sidor till content pages

Hur man applicera teman pa en site

Hur man anvénder MultiView kontroller for att skapa multipla vyer
Hur man interaktivt vaxlar mellan vyer med MultiView kontroller
Hur man anvéander HTTP handlers for att rendera bilder fran en
databas

Titta lite pa det du just dstadkommit. Reflektera lite dver foljande:

e Hur manga rader kod kan du se i .aspx.cs filen? | ASP.NET 1.1 skulle
samma l6sning ha gett minst 100 rader kod troligen narmare 200.



